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Overview
• Excel is a spreadsheet application in the Office 

Suite.

• Spreadsheets are reports that are used for business 
and financial applications that analyze data in a 
table format.

• Perfect for:
– juggling numbers and formulas
– organizing data
– producing polished professional worksheets and reports
– creating charts
– can be used as a simple database program



Structure



Structure

• An Excel file is called a workbook that is 
made up of one or more worksheets.   The 
file has an .xls extension. 

• Worksheets are made up of “cells.”  Users 
enter data and calculation formulas into 
cells. 

• Each worksheet has 256 columns and 
65,556 rows.



• Worksheets can also contain embedded 
objects like charts and pictures.

• Charts are visual displays based on Excel 
data such as graphs, pie charge, etc.  A chart 
can be its own worksheet or embedded in a 
worksheet.

Structure - Charts
(continued)



Screen Elements
Title bar Formatting toolbar Minimize button

Maximize button
Close 
button

Standard toolbar Formula bar
Menu bar

Columns

Scroll bars

Worksheet 
area

Status bar

Cell

Rows



Navigating



You can move from cell to cell using the 
mouse or keyboard.

– To move from cell to cell 
• Click on the cell to which you want to move 

(a dark border called a cell selector, surrounds a 
selected cell)

– To select more than one cell at a time
• Click the first cell you want
• Hold the left mouse button and drag over the cells 

you want to select

Navigating from Cell to Cell



Use the scrollbars to move to different areas 
of a worksheet.

– Click the up or down arrow to move up or 
down.

– Click the left or right arrow to move left or 
right.

– Drag the scrollbar to move quickly
• The row number or column heading is displayed to 

help you know where you are in a worksheet

Navigating to Different Areas 
of a Worksheet



• Move from worksheet to worksheet by 
clicking on the tab at the bottom of the 
workbook.

Navigating from Worksheet 
to Worksheet



A cell address indicates which cell on the 
worksheet you are referring to.  There is a 
navigation box in the formula bar where 
you can type in the cell reference and it will 
go to that cell.  You can also use the F5 key.

Navigating with Cell Addresses



Variations on Cell Addresses

There are two types of cell addresses used 
by Excel:

• the A1 reference method
• The R1C1 reference method

Excel uses, by default, the A1 reference 
method.



A1 Reference Method

– Columns are lettered A through IV
(A to Z, AA to AZ, BA to BZ, and so on, up 

to IV, which is the 256th column)

– Rows are numbered from 1 to 16384

Example:  B3 (Column B, Row 3)



Excel can also use the R1C1 method

– Rows and columns are both numbered

– Example:  R3C2 (Row 3, Column 2)

Identical cell - represented by B3  

R1C1 Reference Method 



Changing Reference Methods

To toggle between the two reference methods

• From A1 to R1C1
– Select Tools from the menu bar
– Choose Options
– Select the General tab
– Select the check box marked R1C1
– Click OK

• From R1C1 to A1
– Follow above process
– Uncheck the check box marked R1C1



• Excel will delete not only the sheet but all the data 
on that sheet.  

• Be sure that you don’t delete sheets that contain 
information you need.  

• When Excel deletes a worksheet, the sheet and all 
of the data on it are permanently gone.

You can add and delete worksheets from 
your workbook file.

Adding and Deleting Worksheets



• Click the worksheet tab before which you want to 
insert a new sheet.

• Open the Insert menu and select Worksheet.

• Excel inserts a new sheet and gives it a default 
name.

Adding Worksheets

To add a worksheet:



• Select the sheet you want to delete.

• Open the Edit menu and select the Delete Sheet 
command (or right-click the sheet, choose Delete 
from the shortcut menu).

• You are prompted to confirm the deletion.

• Click OK.

• Excel deletes the worksheet and all its data.

To delete a worksheet:

Deleting Worksheets



Entering Data



Active Cells and Data Entry
• When you type on the keyboard, the data is 

entered into the “active” cell.  Only one cell at a 
time can be active. 
– A cell is made active by clicking on it.  If there is 

already data in the cell it will be replaced. 
• Enter your data by moving to another cell (Enter 

or arrow keys, or by clicking) or by clicking the 
checkbox.
– When you are in the process of entering data, the 

status bar in the lower left corner will say “enter”  -
when you have entered your data it will say “ready”



Types of Excel Data

Worksheets can contain three types of entries:
• Text or “Labels” - Excel cannot perform 

calculations on entries that are strictly text.

• Values - Excel refers to numerical data as a value.  
Excel can calculate value entries which can include 
numbers, dates and times.

• Formulas and Functions - entries that tell Excel to 
perform calculations on the values in another cell 
or group of cells.



The First Character in a Cell 
Determines the Type of Data

• When an alphabetical character or symbol (‘~ † ! † 
# % ^ & * ( ) _ \ [ ] { } ; : < > , ?) is entered as the 
first character in a cell, the cell contains a “Label.”  
A label is generally text data.

• When a number or symbol (+ - , = $) is entered as 
the first character of a cell, the cell contains a 
value.  To enter a number that will not be used as 
a value it is necessary to begin the entry with a 
label prefix, an apostrophe (’).

• A formula is an instruction to calculate numbers.  
An equal (=) sign always precedes a formula.



You should first plan where you want data to be 
placed on the worksheet.  Then, to begin entering 
data, click inside a cell and start typing.

Plan the Layout of Your Data

• Labels will flow over into the next cell if the 
next cell is empty.  If there is data in the next 
cell the text will truncate.

• If a value is too long for the width of the cell, 
Excel displays number signs (####) in the cell so 
you don’t see a partial value.



Entering Data
(Continued)

Labels

Entries are truncated if 
adjacent cells contain data

Long text entries spill 
over into adjacent cells

Values

Formula



Formulas

In a spreadsheet program like Excel, you can 
use formulas to perform all kinds of 
calculations for you.

Formulas are simply mathematical operations 
you can perform on entries in your worksheet:  

– Addition (+)
– Subtraction (-)
– Multiplication (*)
– Division (/)



Elements of Formulas

• A formula consists of the following key 
elements.
– The Equal Sign (=)
– The values or cell references you want to 

calculate
– The mathematical operators (+ - * / )



• All formulas always start with an equal 
sign:

=A1+A2

This formula takes the value in cell A1 and 
adds it to A2.  The answer will appear in the 
cell.  The formula will appear in the formula 
bar.

Structure of Formulas



You can make compound formulas, mixing 
cell references, values and operator signs.
Excel performs the series of operations 
from left to right in the following order:
– 1st All operations in parentheses
– 2nd Exponential equations or operations
– 3rd Multiplication and division
– 4th Addition and subtraction

Order of Operations in Formulas



Example of Operational Order

Example 1 =A1+A2+D7/12
– In the above example, Excel would divide D7 by the 

value 12, then add A1 and A2.  
– To divide all three references by 12, put them in 

parentheses:

Example 2 =(A1+A2+D7)/12.  
This can lead to very different answers.  If A1 holds the 
value 2, and A2 holds the value 10, and D7 holds the 
value 36, in Example 1 the answer would be 15.   In 
Example 2, the answer would be 4!



Functions

Functions are built-in Excel formulas.

– Like a formula, a function begins with an equal 
(=) sign

– The next part is the function name
• usually a short abbreviated word that indicates what 

the function does

– After the function name you will see a set of 
parentheses, and inside the parentheses, you see 
the arguments (values used in the calculation)



Inserting Functions

Inserting a function using the Paste Function 
button

– Select the cell you wish to place the function in
– Click the Paste Function button

• The Paste Function dialog box appears



• Select the Function category
• Select the Function name
• Click OK

– The Formula Palette will appear prompting you 
for more information

Inserting Functions 
(Continued)



Inserting Functions 
(Continued)

Formula Palette
Function 

argument field
Required arguments 

are listed in bold
The value of each 
argument

The result 
of the 
function

Brief description 
of the selected 
argument

Brief description 
of the function



• When you have completed the required 
information Click OK

– The function is performed and the result placed 
in the selected cell

Inserting Functions 
(Continued)



Formulas or Functions?

• Both formulas and functions begin with an = 
sign.

• Using a formula, you can calculate a series of 
cells with mathematical operators:
=A1+A2+A3 - (B7*C6)/12  (adds the values in the 

cells A1 through A3 and subtracts the value 
determined by  the value in B7 multiplied by the 
value in cell c6 and divides this all by 12 according 
to the order of operations.



Formulas or Functions? 
(continued)

• Using a function, you can refer to a series of 
cells as a range, and use Excel’s predefined 
functions as shortcuts:
=sum(A1:A3)  (adds the values in cells A1 

through A3)
• You can even mix functions with formulas:

=sum(A1:A3)-(B7*C6)/12
(returns the same value as the first example).



Relative Cell Addresses

• Excel uses a concept know as relative 
addressing to make it easy to copy and 
move formulas and functions.

• Excel doesn’t think of the cells you include 
in a formula or function as absolute 
locations on the sheet.

• Instead, Excel thinks of the cells as relative 
to each other.



When you create a formula in cell A3

Example A3=A1+A2

Excel identifies the first cell in the formula 
as two cells above the current one.

Excel thinks, “go up two cells, take this 
value, then go up one cell, take this value, 
and add the two.”

Relative Cell Addresses (Continued)



Relative Cell Addresses in Formulas 
(Continued)

If you move or copy the formula, the same 
set of instructions work in different columns 
and rows.

If you move or copy the formula created in 
cell A3 to cell B3, the formula would adjust 
itself.

A3=A1+ A2 would become B3=B1+B2



Absolute vs. Relative Cell Addresses

In some formulas you may want to always 
refer to a specific cell.

Example:  You have several columns of pricing 
information that refer to one discount rate in 
cell A1.  You always want to refer to cell A1 
(you don’t want the references to adjust)

In this case you would use an absolute 
reference.



Absolute Cell Addresses

• An Absolute reference doesn’t change if the 
formula is moved or copied to another cell.

• You can tell Excel to adjust the column but 
keep the row reference the same, or adjust 
the row but keep the column reference the 
same, or both.



Changing Cell References from 
Relative to Absolute

To change a reference from relative to 
absolute, type a $ sign before the part you 
want to remain absolute

$A1 — Refers always to Column A
(Row will vary)

A$1 — Refers always to Row 1
(Column will vary)

$A$1 — Refers always to cell A1



Building Formulas that 
Contain Absolute References

• Select the cell that will contain the formula
• Type an equal (=) sign
• Click the cell reference you want to include 

in the formula as an absolute reference
• Press F4 — Excel enters dollar signs before 

the column letter and row number of the 
cell reference 

(you can also type in a dollar sign in front of 
the cell reference)



Building Formulas that 
Contain Absolute References 

(Continued)

• Continue building the formula until it is 
complete, pressing F4 every time you want 
to make a cell reference absolute.

• When finished, press Enter and Excel 
creates the formula.



Mixed References

• In some cases you may want to use a mixed 
reference in a formula.

Example:  You might want the row reference to 
stay fixed and the column to be relative.

• Mixed references can contain both absolute 
and relative cell addresses

Example $C6 keeps the column from changing, 
but the row is relative.  If the address is written 
C$6, the column is relative, but the row is 
absolute.



Building Mixed References

• Mixed references can be entered in the same 
way as absolute references.

• Use the F4 key to cycle through adding 
dollar signs to the reference.

Example — If you enter the reference C6, pressing 
F4 will cycle through $C$6, C$6, $C6 and C6



Editing



Cut, Copy and Paste

When you Cut or Copy something it is placed 
on the Windows clipboard.

You can then use the paste command to paste 
the item into the same file, another file, or 
even into another application.



To Copy Data from one cell to another

– Select the cell or range you want to copy
– Select Edit, Copy or click the Copy button
– Select the cell at the upper left corner of where 

you want to paste the information
– Choose Edit, Paste or click the Paste button

• Excel copies the selected cell or range to the 
selected area

Copying Data



NOTE:  A lasso or marquis will remain 
around the cells that have been cut or 
copied and placed on the clipboard.  

This indicates
what data is 
actively on 
the clipboard.

Copying Data
(continued)



To Move Data from One Cell to Another
with Cut and Paste

– Select the cell or range you want to move
– Select Edit, Cut or click the Cut button
– Select the cell at the upper left corner of 

where you want to paste the information
(Excel will overwrite any cells in the 
destination area.)

– Choose Edit, Paste or click the Paste 
button
• Excel moves the selected cell or range.



Paste Special

• Paste Special is used when you only wish to 
copy certain cell attributes from one cell to 
another.

• For example, you might want to copy only 
the formula or just the values from a cell.



• Select the cell or range you want to copy.
• Choose Edit, Copy or click the Copy button.
• Select the cell or range where you want to 

copy to.
• Choose Edit, Paste Special.

– The Paste Special Dialog box appears

Paste Special
(Continued)



Paste Special
(Continued)

• Under the Paste options
– Choose the attributes you 

want copied to the new cells

• Under the Operations 
options
– Choose how you want the 

copied attributes combined 
with the cell or range you’re 
copying to



• If you don’t want to paste any blank cells 
over the existing cells, select the Skip 
Blanks check box.

• To change columns to rows or rows to 
columns, select the Transpose check box.

• Click OK and Excel transfers the attributes 
you selected.

Paste Special
(Continued)



Drag and Drop

If you want to move or copy a selected range, 
you can drag and drop it.

To use this method you have to get the mouse 
pointer in just the right spot.

You then have to drag the range to the new 
location.



• Select the cell or range you want to move or 
copy

• Move the mouse pointer over the selection’s 
border
– The mouse pointer should change to an arrow

Drag and Drop
(Continued)



• To  copy the range

– Hold down the Ctrl key.  A plus sign should 
appear next to the mouse pointer.

• To move the range

– You don’t need to hold down any key, just use 
the mouse

Drag and Drop
(Continued)



• Drag the boarder

– As you drag, you see an outline of the selected 
data

• When the data is in the desired spot, release 
the mouse button

– The data is moved or copied

Drag and Drop
(Continued)



Insert and Delete Cells

To Insert a Cell
– Select the cell
– Choose Insert, Cell
– Select an option from the Insert dialog box

Excel inserts the cell and shifts the existing cells

To Delete a Cell
– Select the cell(s)
– Choose Edit, Delete
– Select an option from the Delete dialog box

Excel deletes the cell(s) and shifts the existing cells 



Inserting Rows and Columns

To Insert Rows or Columns

– Select the row or column
• New rows are inserted above the selected row
• New columns are inserted to the left of the selected 

column

– Choose Insert, Rows to insert a row or Insert, 
Column to insert a column

• Excel inserts the row or column and shifts the 
existing cells over



Deleting Rows and Columns

To Delete Rows or Columns

– Select the row(s) or column(s) you wish to 
delete

– Choose Edit, Delete
• Excel deletes the row(s) or column(s) and shifts the 

remaining cells over



Sizing Columns and Rows

• Changing column widths and heights can be 
done three ways

– Manually
– Using the Column width/height dialog boxes
– AutoFit selection



• Point the the right of the column heading 
border (or the border below the row 
number) that you want to change
– The pointer will change to a thick vertical (or 

horizontal) line with an arrow on either side

Sizing Columns and Rows Manually



• Hold down the mouse button to drag to a 
new width (or height)
– Note the size is displayed as a screen tip next to the 

pointer

Sizing Columns and Rows Manually 
(continued)



• When the column (or row) is the width (or 
height) you want, release the mouse button

Sizing Columns and Rows Manually 
(continued)



Sizing Columns and Rows Precisely 
with a Dialog Box

• Select the column(s) 
you want to change

• Choose Format, 
Column, Width 

• Type a width in the 
Column width box

• Click OK

• Select the rows(s) you 
want to change

• Choose Format, Row, 
Height

• Type a height in the 
Row Height box

• Click OK

Excel adjusts the column or row to the size you specified.



• Select the column(s) or row(s) you want to 
adjust

• Choose Format, Column or Row, AutoFit 
Selection

Excel adjusts the Column or Row to fit the 
widest or tallest entry 

Sizing Columns and Rows with 
AutoFit Selection Command



Hiding Columns and Rows

If you plan to share a worksheet with others, 
you may want to hide confidential 
information from view.

There are two ways to hide Columns and 
Rows.
– Manually
– Using the Hide Command



To hide a column
– drag the right border past the left border

To hide a row
– drag the bottom border up past the top

Hiding Columns and Rows 
Manually



Select the column(s) or row(s) you want to 
hide

– To hide a column 
• choose Format, Column, Hide

– To hide a row
• choose Format, Row Hide

Hiding Columns and Rows 
Using the Hide Command



• To unhide columns
– select the columns on both sides of the hidden 

column(s), then choose Format, Column, 
Unhide

• To unhide rows
– select the rows on both sides of the hidden 

row(s), choose Format, Row, Unhide

Unhide Columns and Rows



Merging Cells in Columns or Rows

• Select the cells or range of 
cells you want to merge

• Choose Format, Cells to 
display the Format Cells 
dialog box

• Click the Alignment tab
• Select the Merge Cells check 

box
• Click OK and Excel merges the selected cells into one
• To split the cells, simply uncheck the Merge Cells box.



Formatting



Formatting

To Format Data in your worksheet you must 
first select the cell or range of cells you wish 
to format.



Formatting can be done two ways
– Using the Format Toolbar

– Using the Format, Cells dialog box

Formatting
(Continued)



The Format Tool Bar

Character 
Formatting

Paragraph 
Formatting

Numeric
Formatting

Paragraph Indent 
Formatting

Border, Fill Color 
and Text Color 

Formatting

To Format using the Format Tool Bar
– Select the cell(s) you want to format
– Click on the button for the type of formatting 

you want to apply



The Format, Cells dialog box allows you to 
change the formatting of

– Numbers
– Alignment
– Fonts
– Cell Colors
– Borders
– Patterns
– Cell Protection

Using the Format Cells Dialog Box



To Center a Heading

– Select the cell that contains the heading and the 
range that you want to center across

– Click the Merge and Center button

– Excel centers the headings across the selected 
columns

Centering Headings



If you don’t know how to format your 
spreadsheet, Excel’s AutoFormat feature 
gives you some professional help.

Excel provides 16 different AutoFormats to 
choose from.

Using AutoFormat



Using AutoFormat 
(Continued)

• Select the data you want to format.
• Choose Format, AutoFormat

– The AutoFormat dialog box appears



• Look through the Table Format list to find a 
formatting style you want to use, then select 
a style from the list

• Look at the sample area to see if you like 
this style

• Click OK when you have found a style you 
like

– Excel formats your data accordingly

Using AutoFormat 
(Continued)



Once you’ve formatted a range the way you want it, 
you may wish to use it on other areas of your 
worksheet.

• Select the cell or cells containing the formatting 
you want to copy.

• Click the Format Painter button on the toolbar.
(The mouse pointer displays a little paintbrush next to the 
cross)

• Select the cells that you want to format with the 
same options.

(When you release the mouse button, Excel applies the 
formatting to the selected range)

Using the Format Painter Tool
(Continued)



You can instruct Excel to change the 
formatting for a cell automatically if the cell’s 
value changes, based on the criteria you 
establish for a change.

– EXAMPLE - If the value of a cell falls below 
zero, you can instruct Excel to flag the cell with 
a heavy read line and shading, and boldface the 
text.

Conditional Formatting



• Select the cell(s) containing the value or 
formula you want to format with conditional 
formatting.

• Choose Format, Conditional Formatting.
– The Conditional Formatting dialog box appears 

Conditional Formatting
(Continued)



• Click the drop-down list at the far left of the 
box and choose the Cell Value Is option.

– This is the option you want to use if the cell’s 
formula produces a value.

– If the cell contains a formula whose value is 
True or False, choose the Formula Is option.

Conditional Formatting
(Continued)



• In the next drop-down list, designate an 
argument to activate the conditional format 
in the cell.

– Click the drop-down arrow to display a list of 
arguments.

– Depending on the argument you select, the 
remaining text boxes will vary.

Conditional Formatting
(Continued)



• In the remaining text boxes, finish entering 
the data to complete the condition for 
formatting the cell.

• To specify formatting for the cell, click the 
Format button.
– The Format Cells dialog box appears.

Conditional Formatting
(Continued)



• When you finish assigning formatting, click 
OK
– You will be returned to the Conditional 

Formatting dialog box where you can see a 
preview of the formatting you’ve selected.

• Click OK to exit the dialog box
– Anytime the cell value meets the requirements 

for conditional formatting, Excel applies the 
formatting options you selected.

Conditional Formatting
(Continued)



Previewing Worksheets



Preview a Worksheet

• To preview a worksheet, click the Print 
Preview button.
– The preview window appears



Preview Toolbar

– Displays the next page.

– Displays the previous page.

– Makes the preview screen larger, Click the 
button again to return to the original size.

– Prints the worksheet.

– Displays the Page Setup dialog box so you can 
make changes to the layout of the page.



– Displays on-screen margin indicators you can 
drag to change margins.

– Lets you designate page breaks within your 
worksheet.

– Closes the preview window.

– Displays help information about preview.

Preview Toolbar
(Continued)



Printing



Print Area

Unless you tell Excel differently, the portion 
of  the worksheet with data and formatting is 
printed when you choose the print command.

You can also define a specific range to print.



Defining the Print Area

To Define a Print Area

– Choose File, Page Setup to open the Page Setup 
dialog box.

– Click the Sheet tab to bring it to the front of the 
dialog box.

– Click the Print Area text box.
– Select the range of cells you want to define as 

the print area.
– Click OK to exit.



Printing

• To print a single copy of the default print 
selections, you can click the Print button.

• To print only certain pages, multiple copies 
or control how the file is printed, use the 
print dialog box.

– Select File, Print
• The print dialog box appears



– Under the Print Range options, select which pages 
to print.

– To print the entire file select All
– Type the number of 

copies you want or use 
the spin arrows to set a 
number

– To print certain 
portions of your 
worksheet, use the print 
What options

– Click Ok to print

Printing
(Continued)



Setting Print Options in Page Setup

Additional Print 
Options such as 
orientation, 
margins, headers 
and footers and 
gridlines can be 
assigned using the 
Page Setup dialog 
box found under 
the File menu.



Charts



Charts

• ...are a  visual representation of the data 
contained in your worksheet.

• …communicate data and results more 
concisely and powerfully.

• …let the reader instantly see the point that 
you want to make.



Chart Elements

• Data Series - the values the chart represents
• Series Labels - labels that identify each data 

series shown in the Legend.
• Category Labels - labels that identify the 

data series on the horizontal x-axis.



Creating Charts with Chart Wizard

• Select both the data itself along with any 
labels that describe the data that you want to 
chart (you don’t have to, but it saves time)

Selected 
Data



Starting Chart Wizard

• After selecting the data, click the Chart 
Wizard button



Choosing the Chart Type 
and Sub-type

• On the Standard Types tab you can click on the 
various types of Excel charts, then choose the 
style.

– You can also choose from a 
variety of other chart types 
by clicking the Custom 
Types tab

– Custom Types are charts 
are based on standard 
charts that have modified 
and saved as a chart type 
by the user.



Common Types of Charts 

• Column Charts - Compare individual or sets of 
values.  The height of each bar corresponds to the 
value in the worksheet.

• Pie Charts - show the relationship of each value to 
the other values in the range in a circular graph.  
Only one data range can be used to represent the 
values for the pie slices.

• Line Charts connect data points with lines, so they 
are useful for plotting trends to show changes over 
time effectively.



Select and Orient the Data 
Range and Series

• On the Data Range 
tab, select the range 
on which the data is 
based using the 
Data Range field 

(if you didn’t select 
the range of data 
before starting Chart 
Wizard, you can do 
so now)



Select and Orient the Data 
Range and Series

(Continued)

• The Series tab on 
Chart Wizard’s Step 2 
dialog box lets you 
control how the data is 
displayed in series.



Select and Orient the Data 
Range and Series

(Continued)

• Orient the range of data on the chart using 
the rows and columns option buttons

– When you choose Rows, each row of data on 
the worksheet will be treated as a chart series

– Choosing Columns causes each column of data 
to become a chart series.



Series Options

• Add or Remove a Series

– When you click Add a new series, a new series 
is instantly created

• You then use the other fields in the Series tab to fill 
in the details

– To remove a series, select it in the Series list 
and then click remove



Series Options (Continued)

(Continued)

• Name a series

– Select a series in the Series List

– use the Name field to choose a different chart 
cell that contains the label for that series (you 
can also type any label that you want in the 
name field



Series Options
(Continued)

• Select (or reselect) the data on which a 
series is based

– Chose one of the series listed in the Series  List

– Use the Values field to choose a new range of 
data (you can also type the values you want to 
use by entering them directly with each value 
separated from the next with a comma



Series Options (Continued)

• Change the category labels

– Use the Category (X) Axis Labels field to 
change the names used to identify each cart 
category along the bottom axis of the chart

• You can choose a new worksheet range in this field, 
or you can type each label, separating each from the 
next with a comma



Setting Chart Options

The options you can select from in this 
dialog box are

• Titles
• Axis
• Gridlines
• Legend
• Data Labels
• Data Table



Choose a Location for the Chart

Determine the location for the chart you are 
creating.  

You can

– Embed the chart as an object in a worksheet

– Create a separate chart sheet in the workbook 
that displays the chart



Choose a Location for the Chart
(Continued)

• Choose New Sheet or As Object In...

– As New Sheet field lets you name the resulting 
chart tab in the workbook

– As an Object In field lets you select from existing 
worksheets

• Make the appropriate changes to the associated 
fields

• After you’ve made your selections, click Finish



Modifying Charts 

• The Chart Wizard isn’t only for creating 
charts - you can modify existing charts

• Each step of the Chart Wizard can be 
accessed individually through commands in 
the Chart menu and there are shortcuts in 
the Chart Toolbar.

• You must select the chart to see the Chart 
menu and the Chart Toolbar!



Working with Charts

Chart Wizard’s dialog boxes don’t let you 
choose chart element colors, add floating 
text to the chart, or choose different data 
markers.
To make these other types of changes, you 
have to edit the chart directly.
You can right click on the various chart 
elements for a shortcut menu of relevant 
commands, or use the Chart Toolbar.



Using the Chart Toolbar

Data Table

Legend

Chart Type

Format Object

Chart Object

Angle Text Downward 
and Angle Text Upward

By Row and 
By Column



Using the Chart Toolbar
(Continued)

The buttons on the Chart toolbar operate as follows:
– Chart Objects - shows all of the selected objects in a chart

– Format Object - displays the format dialog box for whatever object is 
selected

– Chart Type - lets you quickly choose different types of charts

– Legend - an on/off toggle that lets you add or remove a legend in a chart

– Data Table - an on/off toggle that lets you add or remove a data table

– By Row and By Column - determine whether the data series being 
charted are arranged with the series being derived from rows or columns 
in the worksheets

– Angle Text Downward and Angle Text Upward - rotates text 45-
degrees down or up  



Selecting Chart Elements

Normally, you can select chart elements by 
clicking them.

Sometimes it is difficult to select some of 
these elements.  

– There are two other routes open to you. 

• The Chart toolbar’s Chart Objects drop down list

• Select any element, then repeatedly press the right 
or left arrow keys until the charge element you want 
to modify is selected



Selecting Chart Elements
(Continued)

One exception to the single click rule 
applies to certain chart types (bar, column, 
line, and XY scatter) and also to elements 
and markers in chart legends.

Some objects contain sub-objects

– To choose sub-objects
– Click once to select the container object 
– Wait a brief moment
– Click again to select the sub-object 



Choosing a Different Chart Type

There are more than 100 different types and 
sub-types from which you can choose.

– Use the Chart Type button on the Chart toolbar

– Select the chart then choose Chart Type to 
select a different type

(The first method is faster but yields fewer 
choices.)



Adding Elements to Charts

There are many elements you can add to 
charts .

– Legends
– Labels
– Callouts
– Data Tables
– New Series



Adding Legends to Charts

• Click the Legend button on the Chart 
toolbar OR

• Choose Chart, Chart Options to open the 
Chart Options dialog box



Adding Labels to Charts

There are a variety of labels you can use on 
charts

– The main types of chart labels are
• Chart Title
• Axis Titles
• Free Floating Text Labels

To create one of the main labels
• Choose Chart, Chart Options
• Click the Titles tab
• Type the titles you want in the available fields



Adding Labels to Charts
(Continued)

• To create a free-floating label

– Select the Chart area by clicking the chart’s 
background

– Type whatever text you want

• The Text is created in a box that appears in the 
middle of the chart when you press Enter

– Drag the text to any location you want



Adding Callouts to Charts

• A callout is typically a line (with or without 
an arrow) that points out a particular area of 
interest on a chart.

• To create a callout you must first draw the 
callout line, and then you add the text for 
the callout.



Adding Callouts to Charts
(Continued)

– Activate the Drawing toolbar

– Choose either the Line or Arrow line types on the 
Drawing toolbar

– Draw the line directly on the chart

– Add the text for the callout by selecting the chart 
background and typing the text you want.  Press 
Enter when done.

– Move the text (and the line or arrow, if necessary) to 
an appropriate location for the callout.



Adding Data Tables to Charts

Data tables offer the reader the ability to see 
the actual numbers used for the data in the 
chart

– On the Chart toolbar, click the Data Table 
button OR

– Choose Chart, Chart Options and click the Data 
Table tab and select the Show Data Table check 
box to activate the data table



Adding New Series to Charts

Adding a new series of data to charts is 
often necessary when updating.

To Add a series

– With the chart selected, choose Chart, Source Data
– In the Source Data dialog box that appears, click 

the Series tab
– Click the Add button
– Complete the Name and Values fields as 

appropriate
– Click OK to close the dialog box



Reordering Chart Series

Sometimes it is necessary to change the 
order of the series that are charted.

To change the order of series

– Right click any series and choose Format Data 
Series from the shortcut menu

– Move to the Series Order tab
– Select any of the series listed in the Series Order 

list and use the Move Up and Move Down buttons 
to reposition the series in the list

– Click OK and the chart series will be reordered



Formatting Charts



Formatting Charts
The Format Object command can be 
accessed in three ways

– Click the Format Object button on the Chart 
toolbar

– Right click an element and from the shortcut menu 
that appears choose Format object (object changes 
in the command name depending on what object 
you’ve selected)

– Choose Format, Selected object, (object changes in 
the command name depending on what object 
you’ve selected)



Changing Chart Colors, Line 
Styles, and Patterns in Charts

You can choose the colors, line styles and drawing 
pattern that Excel uses for any aspect of its charts.

To format the color, line style, or pattern some 
element

– Right click the element to be formatted
– Choose Format from the shortcut menu
– Click the Patterns tab
– Use the Border and Area sections of the Patterns tab to 

make your choices



Formatting Axes

You can change the formatting of the text 
on the axis, the style of the axis, and the 
scale used for the axis.

To format an axis, right click it and choose 
Format Axis from the shortcut menu.

– The Format Axis dialog box appears



Formatting Axes
(Continued)

– The Format Axis dialog box appears

– Select the options of your choice   



Changing Series Formatting

• To format a data series on a chart, right 
click the series and choose the Format 
option on the shortcut menu.

• Use the options tab to control how the series 
is arrayed on the screen (different options 
will be operative for different chart types).



Changing Chart 3-D View Angle

• To change the perspective for a 3-D chart 
type, right click the chart area and choose 3-D 
View from the shortcut menu
– The 3-D view dialog box will appear



Changing Chart 3-D View Angle
(Continued)

• To use the 3-D View dialog box

– Click the different arrow buttons to rotate the wire-
frame chart in the direction you want to move it

– You can also specify Perspective, Elevation, and 
Rotation fields directly

– Once the wire-frame previews as you want, click 
the Apply button to view the chart in the 
background

– If the new view is acceptable, click OK



Choosing 3-D Bar Shapes

• Right click a series in a 3-D bar or column 
chart

• Choose the format option from the shortcut 
menu

• Click the shape tab
– Choose from a bar, a 

cylinder or two different
types of pyramids and 
cones



Using Rotating Text on Charts

To rotate text objects on charts to any angle 
you want

– Right click the text object you want to rotate 
and choose the Format command from the 
shortcut menu

– Click the alignment tab

– Select your choices

– Click OK



Creating Custom Chart Types

To create a custom chart type

– Format the chart the way you want it

– Select the chart, and choose Chart, Chart Type

– Click the Custom Types tab

– Click the User-Defined option button ( you will 
see a preview of your current chart and a list of 
an previously defined custom chart types)

– Click the Add button



Creating Custom Chart Types
(Continued)

– The Add Custom Chart Type dialog box appears

– Fill in the Name and
Description fields

– Click OK

• Your custom chart type
is added to the chart 
type list and can be chosen for new charts you create



Additional References

• Using Microsoft Excel97 - Que Publishers
• Learning Microsoft Office97 - DDC Publishers
• Microsoft Excel97 Support Line - (425) 635-7070 

(free with a legitimate Product ID number from a 
legal copy purchased at full retail price.)

• Remember to use the Help Menu!


